Instructions for anonymous files

l General Information

Text editors automatically record certain identifying information (sometimes called “identity properties”, or
“metadata”) such as the author’s name, creation date, file name, etc. To ensure that anonymity is maintained,
the name of the person who has edited the file and other identifiers must be removed. Identifying data may be
stocked in different ways and this will depend on the file type and the program used. The following instructions
indicate ways to remove identifying information from files created with OpenOffice Writer (extension .odt), or
Microsoft Office 2010 and Microsoft Office 2007 (extension .doc ou .docx).

I OpenOffice.org Writer 3.4 (OpenDocument .odt) Document

Example: Properties of OpenOffice
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Properties of files containing identifying information Properties of files without identifying information

How to make sure that your file does not contain identifying information:

Before you create or change a document, you must delete your “identifying information”. To do so, start by
closing any OpenOffice.org programs that are open (Writer, Calc, Draw, Base, etc.).
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2. Under the “Tools” menu (at the menu bar at the top
of the program), select “Options”. The “Options —
OpenOffice.org” menu will open.
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3. Under the tab “OpenOffice.org”, select “User Data”.
Your identifying information (company, first name, last
name, street, telephone number, etc.) will then appear
on the right.

Options - OpenOffice.org - User Data
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4. Delete all your identifying information. Next, click on
“OK"” (all fields should now be blank).
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5. For these changes to take effect, you must reset the
document properties. Go to the “File” menu and select
“Properties”. The “Properties” menu will open.
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6. Click on “"Reset”. Your identifying information will
completely disappear. Then click "OK” to confirm.

Total editing time: 00:00:00
Revision number: 1]
Template:
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7. Exit OpenOffice.org Writer (under the “File” menu,
select “Exit").

Ctrl+Q
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8. Restart OpenOffice.org Writer.

8a. If you are an author: create a new file for your
manuscript or open the sample manuscript.

8b. If you are a reviewer: open the file you will be
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I Document dans Microsoft Word 2010 (.doc ou .docx)
Example: properties of a Microsoft Word 2010 document
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Créé Aujourd'hui, 16:33 DElICIEInDIESIen

Derniére impression
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Derniére modification par

Afficher toutes les propriétés
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L_| Cuvrir I'emplacement du fichier
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Properties of files containing identifying information

Properties of files without identifying information

How to make sure that your file does not contain identifying information:

Before you create or change a document, you must personalize your copy of Microsoft Office. First of all, close
any Microsoft Office programs that may be open (Word, Excel, etc.).




1. Start Microsoft Word 2010.

. Microsoft Office

@I Microsoft Access 2010
(&] Microsoft Excel 2010
@ Microsoft InfoPath Designer 2010

@ Microsoft InfoPath Filler 2010

@ Microsoft OneMote 2010

|0] Microsoft Outlook 2010

@ Microsoft PowerPoint 2010

[B] Microsoft Publisher 2010

@ Microsoft SharePoint Workspace 2010
(W] Microsoft Word 2010 [+,

2. Click on the “File” tab, then on
“Info".

3. Under “Prepare for Sharing”,
click “Check for Issues” and
then click “Inspect
Document”.
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with disabilities might find difficult to read.
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Prepare for Sharing
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Check for
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@ % Check Compatibility
Check for features not supported by earlier

versions of Word.

4. In the “Document
Inspector” dialog box, tick the
boxes as appropriate.

Document Inspector A=

w« the document for the selected content, diick Inspect.

’@ “omments, Revisions, Versions, and Annotations
spects the document for comments, versions, revision marks, and ink annotations.

2 ies and Personal i
Tspects for hidden metadata or personal information saved with the document.

[¥] cfistom XML Data
Infipects for custom XML data stored with this document.

V] Hiaders, Footers, and Watermarks
Ifpects the document for information in headers, footers, and watermarks.

1 \visible Content
\ spects the document for objects that are not visble because they have been formatted as

iffvisible. This does not indude objects that are covered by other objects.
\} idden Text
I

Inspects the document for text that has been formatted as hidden.

5. Click on “Inspect”.

Hidden Text
Inspects the document for text that has been formatted as hidden.

6. Check the inspection results in
the “Document Inspector”
dialog box.




7. Click on the “Remove All” tab i e
to remove the masked content sem———
that you wish to delete from o tems were found,
the document. Y ies and Personal nformats P
The following document information was found:
= Document properties
* Author
. w ” - idden =
8. Click “Close” to finish. O B
/i\ Note: Some changes cannot be undone. l
Reinspect Close
The properties of your document have been deleted. Now you must add Paralléles’ user name and initials
(this is very important for the reviewers).
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11. Click on the “General” tab, Word Options i 1
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Quick Access Toolbar
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12. Under “User Name”, write

Paralleles.
Under “Initials”, write P.

Then click on “OK".
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13. Exit Microsoft Word 2010.
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14. Restart Microsoft Word 2010.

14a. If you are an author. create a
new file for your manuscript or
open the sample manuscript.

14b. If you are a reviewer. open
the file that you will be reviewing.

. Microsoft Office
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I Microsoft Word 2007 (.doc ou .docx) Document

Example: properties of a Microsoft Word 2007 document
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] Propriétés de : Paperf docx

] Propriétés de : Paperf.docx

Général | Sécurité | Détals | Novell Version | Versions précédentes

| Général [ Sécurié | Détails | Novel Version | Versions précédentes
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Propriété Valeur
Description

Titre:

Ohbjet

Mots-clés
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Commentaires

m

Origine

Jean Dupond

Demier enregistrement par
Numéro de révision 1
Numéro de version
Mom du programme

(Gestionnairs
Contenu créé 2201.201316:46 -

Supprimer les propriétés et les informations personnelles
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Titre:

Objet
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Commentaires
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Origine
Auteurs
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Numéro de révision 1
Numéro de version

Nom du programme Microsoft Office Word

Entreprise

(Gestionnaire

Contenu créé 22012013 16:50 -

Supprimer les propriétés et les iformations personnelles
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Properties of files containing identifying information

Properties of files without identifying information

How to make sure that your file does not contain identifying information:




Before you create or change a document, you must personalize your copy of Microsoft Office. To do so, start off
by closing any Microsoft Office programs that may be open (Word, Excel, etc.).

1. Start Microsoft Word 2007.

. Microsoft Expression
. Microsoft Office
E Microsoft Office Access 2007
[ Microsoft Office Excel 2007 s
[Z! Microsoft Office InfoPath 2007
(@ Microsoft Office PowerPaint 2007
E, Microsoft Office Publisher 2007 =

[iw, Micrasoft Office Ward 2007

. Outils Microsoft Office
. Microsoft Silverlight
. Microsoft Visual Studio 2005
. Microsoft Visual Studio 2010 Express
. Mozilla Thunderbird
Motepad++

. MNovell -

2. Click on the “Office Button”, in

the upper-left corner of the
program.
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Office Button

Click here to open, save, or print,
and to see everything else you can
do with your document.

3. Click on “Prepare” and then
on “Inspect Document”.

U@

Prepare the document for distribution

Hew
Properties
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~u =1 View and edit document properties, such
7 Open as Title, Author, and Keywaords,
=", Inspect Document
| I Save | 2= Check the document for hidden metadata
- or personal infarmation.

= _ _‘j Encrypt Document

ﬂ Save As j%.l? Increase the security of the document by
adding encryption.

@ g D Restrict Permission S
Grant people access while restricting their  *
ability to edit, copy, and print.

@ Prepare * | Add a Digital Signature
Ensure the integrity of the document by
adding an invisible digital signature,

E Send 3
Mark as Final
Let readers know the document is final and

;EE.}. Publish  * make it read-only.

E Run Compatibility Checker
* Check for features not supported by earlier
Close versions of Word.
2] Word Options ‘ |X Exit Word |
n H ’” i
4.  In the “Document inspector Document Inspector L7 [t

dialog box, tick the boxes as
appropriate.

Tff Qeck the document for the selected content, dick Inspect.

Chistom XML Data

tidden Text

|
' isions, Versions, and Annotations!
spects the document for comments, versions, revision marks, and ink annotations.

[ocument Properties and Personal Information
Iikpects for hidden metadata or personal information saved with the document.
Infspects for custom XML data stored with this document.

Headers, Footers, and Watermarks
I¥spects the document for information in headers, footers, and watermarks.

nspects the document for text that has been formatted as hidden.




5. Click on “Inspect”.

Hidden Text

Inspects the document for text that has been formatted as hidden.

10. In the menu that opens, click
on “Word Options”.

Inspect Close
6. Examine the inspection results
in the “Document inspector”
dialog box.
7. C"Ck on the “Remove a"” Document Inspector lilgw
button to remove the masked Review the inspection rasuis.
content that you wish to @ Comments, Revisions, Versions, and Annotations
delete- Mo items were found,
¥ Document Properties and Personal Information —
The following do:;:wnt information was found:
* Document properties
i’\ Mote: Some changes cannot be undone.
—
8.  Click on “Close” to finish.
i\. Mote: Some changes cannot be undane.
Reinspect ] [ Close J
d
The properties of your document have been deleted. Now you must add Paralléles’ user name and initials (this
is very important for the reviewers).
9. Click on the “Office Button”, in ;:'n;x\\ﬁ H 9 - 0 7 e 2
the upper-left corner of the car
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Prepare the document for distribution

=7 Inspect Document
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Save 4 Check the document for hidden metadata
- or personal information.

=) Encrypt Document
Save As b |} Increase the security of the document by
adding encryption.

Print » '2 Restrict Permission

Grant people access while restricting their
ability to edit, copy, and print.

Prepare Add a Digital Signature
Ensure the integrity of the document by
adding an invisible digital signature.

Send »
Mark as Final
Let readers know the document is
7 Publish » make it read-only.
Run Compatibility Checker
Check for features not suppo
Close versions of Ward.
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Open as Title, Author, and Keywords,
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] Word Options | | X Exit Word




11. Under the “Popular” tab, in
“Personalize your copy of
Microsoft Office”, remove your
name and initials where
needed, so that you can
replace them with Paralléles’
user name and initials.
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Popular - -
>P > 14 Change the most popular options in Word.
Display
Proofing for working with Word
Save Toolbar on selection )
aview (1)
Advanced
tab in the Ribbon
Customize achments in Full Screen Reading view ()
Adddns Color scheme: | Blue |Z|
Trust Center ScreenTip style: | Show feature descriptions in ScreenTips |Z|
Resources Personalize your copy of Microsoft Office
# User name: | Jean Dupond
Initials: I
Choose the languages you want to use with Microsoft Office: | Language Settings...

o

12. Under “User Name”, write
Paralleles.

Under “Initials”, write P.

Then click on “OK".

Personalize your copy of Microsoft Office

Username: | Paralleles

itls: P C—
Choose the languages you want to use with Microsoft Office: | Language Settings...
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13. Exit Microsoft Word 2007.
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14. Restart Microsoft Word 2007.

14a. If you are an author. create a
new file for your manuscript or
open the sample manuscript.

14b. If you are a reviewer. open
the file that you will be reviewing.

. Microsoft Expression

. Microsoft Office
,ﬁ Microsoft Office Access 2007
[ Microsoft Office Excel 2007
[E} Microsoft Office InfoPath 2007
& Microsoft Office PowerPoint 2007
E Microsoft Office Publisher 2007

[iw] Microsoft Office Word 2007

. Qutils Microsoft Office
. Microsoft Silverlight
J Microsoft Visual Studio 2005
J Microsoft Visual Studio 2010 Express
J Mozilla Thunderbird
, Motepad++
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